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RÉSUMÉ. L'ensemble des consignes rassemblées ci-dessous s'organise en trois rubriques. La 
rédaction remercie les auteurs pour le strict respect qu'ils accorderont à ces dispositions. La 
taille de ce résumé ne doit pas dépasser une dizaine de lignes. Il est à composer en Times 
corps 9 italique, interligné 11 points. Un résumé en anglais doit l'accompagner. L'ensemble 
des consignes rassemblées ci-dessous s'organise en trois rubriques. La rédaction remercie 
les auteurs pour le strict respect qu'ils accorderont à ces dispositions. La taille de ce résumé 
ne doit pas dépasser une dizaine de lignes. Il est à composer en Times corps 9 italique, 
interligné 11 points. Un résumé en anglais doit l'accompagner. 

ABSTRACf. The instructions put together below fall into three categories. The editor would be 
grateful to authors for respecting these indications. At times, the length of this summary may 
attain a dozen lines. It is to be written in size 9 italie Times. An abstract in French will be 
joined. The instructions put together below fall into three categories. The editor would be 
grateful to authorsfor respecting these indications. At times, the length of this summary may 
attain a dozen lines. It is to be written in size 9 italie Times. An abstract in French will be 
joined. 

MOTS·CLÉS : un maximum de mots significatifs, en français et en anglais, doivent être isolés 
sous fonne de mots-clés. 

KEY WORDS: a maximum of significant words, in French and in English, will be separated as 
key words. 

Signature de l'article: nom de la revue. Volume X- no X/2000, pages 1 à X 
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1. Introduction 

Ce texte donne les consignes à respecter impérativement pour garantir la 
qualité et l'homogénéité des articles (qui, sauf exception, ne doivent pas dépasser 20 
à 30 pages) à paraître dans les revues publiées par HERMES Science Publications. 
Le présent texte doit être considéré comme un modèle, notamment pour la première 
page, l'en-tête, les inters, etc. Vous trouverez en annexe II, la liste des logiciels 
acceptés par le service informatique. 

2. Présentation 

L'ensemble des textes est composé en Times romain (Times New Roman sous 
PC) corps 10, minuscule, interligné 12 points exactement, sans césure dans le texte, 
avec un alinéa de première ligne de 5 mm. Un espace de 6 pts est défini après 
chaque paragraphe (format>paragraphe>espace après: 6 pts). Veiller aux lignes 
seules en bas et haut de page (format>paragraphe>enchaînement>éviter veuves, 
orphelines). 

Les titres et sous-titres font l'objet d'un traitement particulier, expliqué ci-après. 
Par ailleurs, les auteurs qui désirent mettre en valeur un terme peuvent le faire en 
utilisant l'italique ou le gras, mais jamais le soulignement. Eviter au maximum 
d'utiliser les lettres majuscules dans les titres et dans le texte. 

2.1.Format 

Les pages possèdent les caractéristiques suivantes: 

-largeur des textes (ou justification): 120 mm exactement, 
-hauteur des textes, y compris les notes: 190 mm maximum. 
La 1· page de l'article fait l'objet d'une mise en forme particulière détaillée en 

2.2.1. Sur cette première page apparaissent : le titre de l'article, les nom et prénom 
des auteurs, leur appartenance, un résumé et des mots-clés en français et en anglais. 

L'article commence en haut de la page 2. Tous les textes sont justifiés. 

2.1.1. Marges et format 

Si vous utilisez Word sous PC ou Macintosh, les marges à définir sont les 
suivantes, pour justification et hauteur de page de façon à obtenir un bloc texte de 
120 mm x 190 mm; dans Menu, aller à: 

- Fichier>Mise en page> Marges : H 
B 
G 
D 

5,35 cm Exactement 
5,35 cm Exactement 
4,5 cm En-tête 4,4 cm 
4,5 cm Pied de page 4,4 cm 
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>Disposition> En-têtes> pages paires et impaires différentes 
> 1 o page différente 

-Fichier> Format d'impression> A4 
-Outils >Options> Impression> Réglage fin pour largeur (sur Mac) 

> Composition automatique > Remplacer guillemets " par « » 

2.1.2. En-tête 

La pagination et les titres courants de l'article sont insérés dans l'en-tête, en 
Times romain maigre, corps 9. 
Affichage > En-tête > : 
> en-tête page paire > insérer le numéro de page (#) suivi de 5 espaces blancs et du 
nom de la revue ; 
> en-tête de page impaire > insérer le titre courant de l'article ( 40 caractères 
maximum) puis 5 espaces et le numéro de page. 

2.2. Titres et sous-titres 

2.2.1. Première page de l'article 

- Le titre de l'article en français, [indiquer en annexe le titre en anglais (ou 
l'inverse selon la langue utilisée)] doit être informatif et concis (de 3 à 8 mots 
significatifs). Dans le cas où il excède 40 caractères, l'auteur en fournit une version 
abrégée (pour le « titre courant » à insérer par vos soins dans l'en-tête des pages 
impaires). Le titre est composé en corps 18 gras romain minuscule, interligné 20 
points exactement, aligné à gauche. Il est précédé d'une ligne de blanc et bordé d'un 
trait supérieur fin distant de 20 pts. (Format > Bordure supérieure > trait 114 ; option 
> distance du texte > haut : 20 pts). Il est suivi de deux lignes de blanc, interlignées 
12 pts exactement. S'il y a un sous-titre, il est en corps 14 gras romain précédé et 
suivi, comme le titre, de deux lignes de blanc. 

- Le prénom et le nom des auteurs sont composés en corps 12 gras romain 
minuscule, interlignés 14 points. 

-Les coordonnées des auteurs (appartenance, adresse professionnelle et adresse 
électronique, pas de téléphone ni de fax) sont composées en corps 10 italique 
maigre, interligné 12 points. Elles sont précédées et suivies d'une ligne de blanc. 

Un modèle de première page comportant plusieurs auteurs à des adresses 
différentes est donné en annexe 1. 

- Le résumé et les mots-clés sont indiqués impérativement en français et en 
anglais, dans l'ordre suivant: résumé, abstract, mots-clés, et keywords si l'article est 
rédigé en français. Abstract, résumé, keywords et mots-clés si l'article est en 
anglais. 

Cet ensemble est composé en corps 9 italique maigre, minuscule, (sauf les 
termes : RESUME. ABSTRACf. MOTS-CLES : KEYWORDS: qui sont en capitales accentuées en 
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corps 7) interligné 11 points et espacés de 3 pts entre les paragraphes. Le premier 
paragraphe (résumé) est bordé d'un trait supérieur fin distant de 4 pts et le dernier 
(Keywords) est bordé d'un trait inférieur fin distant lui aussi de 4 pts. 

- En pied de page de cette première page figure la signature de 1' article 
comportant le nom de la revue, le numéro du volume et l'année de parution ainsi 
que la pagination de l'article. Elle est composée en corps 9 romain maigre, 
minuscule, et sera mise à jour lors de la composition du numéro de la revue par le 
service fabrication. 

2.2.2. Titre des paragraphes ou titre d' « inter» 

Ils sont tous alignés à gauche, sans alinéa, en numérotation décimale : 
- le premier niveau est en Times corps 10 minuscule, chiffres et texte en romain 

gras (exemple: 2. Titre de niveau 1), 
- le deuxième niveau est en Times corps 10 minuscule, chiffres en romain gras, 

texte en italique gras (exemple: 2.1. Titre de niveau 2), 
- le troisième niveau est en Times corps 10 minuscule, chiffres en romain 

maigre, texte en italique maigre (exemple: 2.1.1. Titre de niveau 3), 
- le quatrième niveau est en Times corps 10 minuscule, chiffres et texte en 

romain maigre (exemple: 2.1.1.1. Titre de niveau 4). 
Chaque titre d'inter de premier et deuxième niveaux est précédé de deux lignes 

de blanc et suivi d'une ligne de blanc; chaque titre d'inter de troisième et quatrième 
niveaux est précédé d'une ligne de blanc et suivi d'une 1/2 ligne de blanc (6 pts). 

Les inters ne doivent pas être isolés en bas de page, mais toujours suivis d'un 
paragraphe ( format>paragraphe>enchaînement>paragraphes solidaires) 

2.3. Les alinéas 

Ils sont de 5 mm. <Format>paragraphe>retrait> 1 ~re ligne>positif>0,5cm. 

2.4. Les notes de bas de page' 

Elles sont en corps 9, interligné 11 points, justifié sans alinéa, numérotées de 1 à 
n à l'intérieur de l'article, surmontées d'un filet maigre de 2,5 cm. L'appel de note 
dans le texte est en corps 8. 

2.5. Figures et tableaux 

1. Note composée en corps 9, sans alinéa. 
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Les figures, illustrations et tableaux doivent être incorporés au texte. Les figures 
et illustrations sont numérotées de 1 à n à l'intérieur de l'article, les tableaux 
également. Des légendes explicites les accompagnent, composées en Times corps 10 
justifiées, sans alinéa, Figure x en romain gras suivi d'un point gras, texte en italique 
maigre. 

Cadre et quadrillage en trait fin. Une ligne de blanc au-dessus, une ligne de blanc entre la 
figure ou le tableau et la légende. Deux lignes de blanc sous la légende. 

Figure 3. Consignes 

2.6. Formules 

Les formules qui font l'objet d'un renvoi dans le texte sont numérotées de [1] à 
[n] entre crochets. Ce numéro, placé sur la première (ou la dernière) ligne de la 
formule, est aligné sur la marge de droite. Une ligne de blanc au-dessus et au­
dessous de la formule la sépare du texte. Si la formule doit être coupée (pour cause 
de longueur) mettre 112ligne de blanc entre les lignes de l'expression. 

2. 7. Enumérations 

Les auteurs utiliseront uniquement des tirets, de différentes tailles s'il existe 
plusieurs niveaux. Ne pas utiliser de puces ou de flèches. Exemple : 

- Les auteurs utiliseront uniquement des tirets, de différentes tailles ... 

- Les auteurs utiliseront uniquement des tirets, de différentes tailles ... 

Pour ces énumérations, les paragraphes sont espacés de 3 pts seulement (au lieu 
de 6 pts habituellement). Le texte doit toujours revenir en début de ligne et respecter 
la justification (largeur de la ligne) de 120 mm. 

2.8. Remarque ou note 

Les termes « remarque » ou « note » se composent en petites capitales maigres 
suivies d'un point, puis d'une espace, puis d'un tiret long: 
NOTE. - ... REMARQUE. - ... 

2.9. Typographie 

-Pour les textes rédigés en français : 
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-Les signes suivants[:;? %], se composent avec une espace insécable avant et une 
espace après. 
-La virgule et le point n'ont pas d'espace avant. 
- Les guillements typographiques ont « une espace insécable avant » 

-Les signes: (parenthèses) {accolades} [crochets] n'ont pas d'espace à l'intérieur. 
- Points de suspension •.• (sans espace avant) 
- Une espace avant et après les signes : = , + , -

-Pour les textes rédigés en anglais, la typographie est différente (pas d'espace 
avant les : ; ? % et guillemets ''pour l'anglais" sans espace). 

2.10. Remerciements 

Le texte des remerciements se place après la conclusion, séparé de celle-ci par 
deux lignes de blanc, avant la bibliographie, sous la forme suivante : 

Remerciements 

Les auteurs tiennent à remercier le laboratoire pour son soutien ... 

2.11. Bibliographie 

Composées en corps 9 romain, interligné 11 points, les références sont 
rassemblées en fin d'article par ordre alphabétique, espacées les unes des autres de 
6 points. Leur numéro, du type [KOL 97], est placé entre crochets. Le nom de 
1' auteur est composé en petites capitales. Elles sont justifiées avec un alinéa négatif 
de 5 mm (Format> Paragraphe> Retrait de 1"' ligne Négatif de O,S cm). 

Voici, en guise d'exemple, quelques cas de figures parmi les plus courants: 

-pour les ouvrages (titre en italique, le reste en romain) 

[KOL 97] KOLSKI C., Interfaces homme-machine, Paris, Editions Hermès, 1997. 

- pour les revues et actes de conférences publiés (titre de la revue ou de la 
conférence en italique, le reste en romain) 

[DEM 941 DEMEURE 1., FARHAT J., «Systèmes de processus légers :concepts et exemples», 
Technique et Science Informatiques, vol. 13, n° 6, 1994, p. 765-795. 

[LAL 97] LALLOUET A., « DP-LOG : un langage logique data-parallèle», Actes des 
6" journées francophones de programmation logique et programmation par contraintes 
JFPLC'97, Orléans, 26-28 mai 1997, Paris, Editions Hermès, p. 53-68. 

-pour les rapports internes et les thèses (texte tout en romain): 

[BRA 95] BRAUN T., DIOT C., HOGLANDER A., ROCA V., An experimental user leve! 
implementation of TCP, rapport de recherche n° 265, septembre 1995, INRIA. 
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[NA W 97] NA WROCKI A., Contribution à la modélisation des câbles monotorons par éléments 
finis, Thèse de doctorat, Université de Nantes, 1997. 

2.12. Biographie 

Pour les revues qui demandent une biographie, les auteurs indiquent en quelques 
lignes, placées en fin d'article, les événements essentiels de leur carrière en insistant 
sur leurs domaines d'intérêt techniques et scientifiques. Ce texte est composé en 
Times corps 9 italique, interligné 11 points, justifié sans alinéa, séparé de la dernière 
ligne de l'article par deux lignes de blanc, nom de l'auteur en caractères gras, texte 
en caractères maigres. Une ligne de blanc est insérée entre chaque auteur. Exemple : 

Béatrice Sorel est ingénieur ... Elle est actuellement allocataire de recherche et prépare une 
thèse au sein du ... Ses travaux portent sur l'utilisation de techniques formelles pour la 
vérification, la validation et la simulation du GRAFCET. 

Yves Saulnier est professeur agrégé et docteur de ... en automatique. Il est actuellement 
maître de conférences habilité et directeur du .... Ses activités de recherche concernent les 
méthodes d'ingénierie intégrée des systèmes de production complexes ... 

3. Remise des articles 

Les articles adressés en soumission seront envoyés en 6 exemplaires au rédacteur 
en chef de la revue concernée, auprès de HERMES Science Publications. Tous les 
documents étant numérisés, nous remercions les auteurs de bien vouloir prendre 
contact, dès la saisie de leur article, avec le service informatique, afin de vérifier la 
compatibilité des fichiers et les sources utilisées. 

Les articles, après acceptation définitive, seront adressés en document attaché à: 
hermes@iway.fr ou sur disquette, accompagnés de deux sorties papier laser, pour 
document témoin, [et d'une copie des polices de caractères utilisées, dans le cas de 
symboles particuliers] en spécifiant bien à l'attention du service fabrication le 
logiciel utilisé par l'auteur. Les auteurs ayant utilisé Latex effectueront eux-mêmes 
les corrections nécessaires et renverront la version corrigée de leur article en 
adressant le fichier PS sur hermes@iway.fr 

De plus, nous prions les auteurs de nous fournir les éléments suivants : 

-le titre de l'article en anglais (pour le sommaire de la revue) 
-un titre court pour le haut de page (ne dépassant pas 40 signes) 
- un formulaire de copyright est à récupérer sur le Web et à nous retourner 

signé. 
- leurs diverses coordonnées : téléphone, télécopie et adresse électronique. 

Le service Fabrication de Hermes Sciences Publication reste à votre disposition 
pour toute information complémentaire. 
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Annexe 1 

Nous donnons ci-dessous un modèle de présentation du haut de première page 
dans le cas de plusieurs auteurs avec plusieurs appartenances. Les noms des auteurs 
sont séparés par un tiret long (caractère spécial) maigre. L'appartenance est notée 
par une (ou plusieurs) étoile(s) placée(s) en correspondance avant le texte de 
l'appartenance. Pour une adresse électronique commune à plusieurs auteurs, les 
noms des auteurs sont réunis entre deux accolades, séparés chacun par une virgule. 

Si l'article appartient à une rubrique, le nom de celle-ci est inséré au-dessus du 
filet supérieur, composé en capitales, Times corps 12 maigre. Exemple: 

RECHERCHE 

Couplage endommagement du béton 

Etude d'une modélisation numérique 

Laurent Molez*'** -Bruno Gérard**- Gilles Pijaudier *, *** 
*Laboratoire de Mécanique et Technologie, ENS de Cachan 
CNRS/Université Pierre et Marie Curie 
61 avenue du Président Wilson, F-94235 Cachan cedex 

{nom, nom}@laboratoire.fr 

** Electricité de France, Direction des Etudes et Recherches 
Dépt. MTC, BP 1, F-77818 Moret-sur-Loing cedex 

***Institut Universitaire de France 

Annexe II : liste des logiciels acceptés 
- Word 6 et Word 98 sous Macintosh ; Word 6 et 7 (Word 95) et Word 97 sous PC 
- Latex version 2 
Les feuilles de style sont disponibles sur : 
http://www.hermes-science.com/cad_aute.htm 

HERMES SCIENCE PuB LI CA TI ONS 

8 Quai du Marché Neuf- 75004 Paris 
Tel: 01-53-10-15-20 Télécopie: 01-53-10-15-21 

E-mail : hermes@iway.fr 
Serveur Web: http//www.hermes-science.com 


